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Introduction  
The MapWindow application is a free, extensible geographic information system (GIS) that can be 
used in many ways:  
 

• As an open-source alternative desktop GIS  
• To distribute data to others  
• To develop and distribute custom spatial data analysis tools  

This User Guide is only intended for use with the MapWindow Desktop GIS Application. 

Features:  
As an open-source tool, MapWindow is free to use and redistribute to the user clients and other end 
users. It may also be modified to fit the user needs, or embedded into proprietary software.  
  
MapWindow is more than just a data viewer. It is an extensible geographic information system. 
This means that advanced users or developers can write plug-ins to add additional functionality 
(models, special viewers, hot-link handlers, data editors, etc) and pass these along to any number of 
the users clients and end users.  
  
MapWindow includes standard GIS data visualization features as well as DBF attribute table 
editing, shapefile editing, and data converters. Dozens of standard GIS formats are supported, 
including Shapefiles, GeoTIFF, ESRI ArcInfo ASCII and binary grids.  

Getting the Software 
The MapWindow GIS software is freely available to download from the MapWindow website 
www.mapwindow.org. 
 
In addition, there are further Plug Ins to add capability to the base software for download from the 
site. 

Getting Plug-ins 
MapWindow GIS software installer will provide a range of the key plug-ins required for use, 
including GIS Tools, Shapefile Editor plus others.  There are additional plug-ins available from the 
MapWindow website downloads page, or from links in the Sample Code Forum. New plug-ins are 
constantly being developed, so it is advised to check the website. 
 
To enable a new plug-in; 

� Download the file from the website – these are usually in .zip compressed files 
� Extract the plug-in file, usually with a .dll extension 
� Save this file into the Plug ins folder, usually C:\Program Files\MapWindow\Plug ins 
� Start MapWindow GIS, click on [Plug-Ins] in the menu, and select the plug-in name 

Getting GIS Data 
GIS Datasets may be available online depending upon your country, or check with your nearest 
Regional or State Natural Resource Management authority or agency.  Links to GIS datasets are 
available from the MapWindow website 
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Starting MapWindow 
Either double click on the MapWindow icon on your desktop, or select the program from your 
programs list. MapWindow will open with a new, empty Project, showing as below. 
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MapWindow Interface  
This is the front end or interface users will work with, as shown above. 

The Standard Toolbars  
In the upper left corner of the program is a toolbar with several drop-down menus. Each of the 
drop-down lists has several functions within them.  
 

 
 

1. [FILE]  
• [NEW] - Create a new project  
• [OPEN Project] - Opens an existing project file  
• [GEODATABASE] – not covered in this manual 

-------------------------------------------------------------  
• [OPEN PROJECT IN NEW GROUPS]  

----------------------------------------------------------------------------------------------  
• [SAVE] - Save under an existing project name  
• [SAVE AS] - Save as a new project  

----------------------------------------------------------------------------------------------  
•  [PRINT] - Prints a hard copy of the map  

----------------------------------------------------------------------------------------------  
•  [SETTINGS] - Controls general preferences of the application  
•  [RECENT PROJECTS] - Contains a list of recently opened projects.  

----------------------------------------------------------------------------------------------  
•  [CHECK FOR UPDATES]  checks for new software updates  

----------------------------------------------------------------------------------------------  
•  [CLOSE]  close the project but not the program  
•  [EXIT] - Closes the program  

 
2.  [EDIT]  

•  [COPY >] - Places any of the following elements on the system clipboard.  
o  [MAP]  
o  [LEGEND]  
o  [SCALE BAR]  
o  [NORTH ARROW]  

•  [EXPORT >] Exports any of the following elements to a graphic file.  
o  [MAP]  
o  [GEOREFERENCED MAP] - Exports a geo-referenced image from the 

current map view  
o  [SCALE BAR]  
o [NORTH ARROW]  

----------------------------------------------------------------------------------------------  
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•  [PREVIEW MAP>]  

o  [UPDATE USING FULL EXTENTS] - Updates or refreshes the Preview 
Map Pane  

o  [UPDATE USING CURRENT VIEW]  
o  [CLEAR] - Clears the Preview Map Pane  

3. [VIEW]  
•  [ADD LAYER] - Adds a geospatial layer to the map.  
•  [REMOVE LAYER] - Removes the selected geospatial layer.  
•  [CLEAR LAYERS] - Clears all layers from the map.  

----------------------------------------------------------------------------------------------  
•  [SET MAP SCALE]  
•  [SHOW FLOATING SCALE BAR]  

----------------------------------------------------------------------------------------------  
•  [ZOOM IN] - Changes the current cursor behavior to zoom in mode  
•  [ZOOM OUT] - Changes the current cursor behavior to zoom out mode  
•  [ZOOM TO FULL EXTENTS] - Zoom the map to the full extents of all currently 

loaded data  
•  [ZOOM TO PREVIOUS MAP EXTENTS]  

----------------------------------------------------------------------------------------------  
•  [PREVIOUS ZOOM] - Will return the map to the previous zoom.  
•  [NEXT ZOOM] - This is used with Previous Zoom to move back and forward 

within saved zoom extents.  
----------------------------------------------------------------------------------------------  

• [PANELS>]  
o  [SHOW LEGEND]  Hide or show legend  
o  [SHOW PREVIEW MAP]  Hide or display Preview Map  

----------------------------------------------------------------------------------------------  
4.  [PLUG-INS]  

• [EDIT PLUG-INS] 
• [SCRIPTS…] 
• ----------------------------------------------------------------------------------------------   
• [CSV TO SHAPEFILE CONVERTER]  
• [DOCUMENT LAUNCHER]  
• [GIS TOOLS]  
• [SHAPEFILE EDITOR]  

----------------------------------------------------------------------------------------------  
5.  [HELP]  

  

• [MAPWINDOW DOCUMENTATION ONLINE] -  
• [MAPWINDOW DOCUMENTATION OFFLINE]  

----------------------------------------------------------------------------------------------  
•  [KEYBOARD SHORTCUTS]  

----------------------------------------------------------------  

•  [WELCOME SCREEN] - Will display the Welcome Screen  
•  [ABOUT] - Will display the About screen  



Quick Guide to MapWindow   7 

Toolbar Icons 

 
 

- New Project  - Open Project   - Save Project   - Print Map 
  

- Add Map Layer  
[ADD LAYER]  
[REMOVE LAYER]  
[CLEAR LAYERS]  

 

- Pan (move view)  - Select (feature) 
  

-Measure Distance    - Measure Area  
  

- Zoom In    - Zoom Out    

- Zoom  

 [PREVIOUS]  

 [NEXT]  
[ZOOM TO PREVIOUS MAP EXTENTS]  
[FULL EXTENTS]  
[LAYER]  
[SELECTED]  

 
 
 

Additional (PLUG-INS) Menus:  
 
If the user clicks on the [PLUG-INS] menu item, a drop-down menu will appear. By clicking on 
different plug-in names the user can add extra menus and toolbar buttons.  
 

6. [GIS TOOLS] - Generic vector and raster tools for MapWindow  
• [RASTER > ] (this menu is for image and grid files). 

o [ASSIGN PROJECTIONS TO GRIDS] 
o [REPROJECT GRIDS] 
o [CHANGE GRID FORMATS] 
o [CREATE GRID IMAGES] 
o [RESAMPLE GRIDS] 
o [MERGE GRIDS] 
o [CLIP GRID WITH POLYGON] 
o [GEO-REFERENCE AN IMAGE OR GRID] 
o [GENERATE A CONTOUR SHAPEFILE] 
o [CHANGE NODATA VALUE] 
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•  [VECTOR > ] (this is the main menu for shapefiles) 
o [ASSIGN PROJECTION TO SHAPEFILE]  
o  [REPROJECT A SHAPEFILE]  
o  [BUFFER SHAPES]  
o  [CACULATE POLYGON AREAS]  
o  [CLIP POLYGON WITH LINE]  
o  [CLIP SHAPEFILE WITH POLYGON]  
o  [ERASE SHAPEFILE WITH POLYGON]  
o  [EXPORT SELECTED SHAPES TO NEW SHAPEFILE]  
o  [EXPORT SHAPES TO NEW SHAPEFILE BY MASK]  
o  [MERGE SHAPES]  

•  [IMAGES>]  
o [ASSIGN PROJECTIONS TO IMAGES] 
o [RECTIFY IMAGE TO WORLD FILE] 
o [REPROJECT IMAGE] 

 
7. [SHAPEFILE EDITOR] - Edit and create shapefiles and shape geometry.  

 
 

•  -Create New Shapefile  

•  - Add new Shape to current Shapefile  

• - Remove Shape from current Shapefile  

•  -Move an existing vertex in a shape  

•  - Add a vertex to an existing shape  

•  - Remove a vertex from an existing shape  
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Using MapWindow GIS 
The first time you open MapWindow, you will need to turn on some tools and plug-ins, and alter 
settings to suit your normal use. 

Turn on Plug Ins 
Plug Ins are extra tools and capabilities which you will need to enable to create and edit files. The 
ones most likely to be used for projects are the GIS Tools and Shapefile Editor. 
 
In the top menu, click on [Plug-ins], then select GIS Tools.  Repeat to select Shapefile Editor.  This 
will then open the additional menu’s and toolbar icons for each of these as listed in the Toolbars 
section. 
 

Projects  

Creating a New Project  
A Project is a file which is a record of the different layers, images, labels, colours and styles you set 
for viewing these.  This Project will keep a record of these and other settings, so that the next time 
you open this project, all will be the same as the last time you saved the Project.  A Project file will 
have a format of projectname.mwprj and is different from the data files you will have or create 
(shapefiles). 
 
To create a new project, open MapWindow.  This will start with a new, empty Project to which you 
can add data. 

Project Settings 
Modifying some of the default settings will assist you to 
use MapWindow projects later, and set the specifics of 
the project. 
 
Once you have a Project open, click on [FILE]…then 
click on. [SETTINGS]. This will open the settings list as 
right.  Most of these fields do not need to be edited, but 
to alter a setting click on the right column of the item, 
then click on the drop down arrow, and select the item 
from the drop down list. 
 
Set the following: 

� Map Data Units – set to your preference 
� Show Additional Units – can be left off, or 

choose Lat/Long  
� Show Map Data Units to True to show or False 

to turn off the Units display 
Leave File formats and Map Behaviour as default 

� Project Projection – see section below 
� Display Welcome Screen – Select True will 

show a welcome screen whenever you start 
MapWindow, including a shortcut to Projects you have used before. 
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Project Projection  
Map Datum and Projection are particular aspects to GIS data.  These tell the system where on the 
Globe the area is, and the best display for this.  You will need to check the correct datum where you 
access your GIS datasets, or from your regional Natural Resource Management agency.  Some 
datasets will be in global datum, and not projected. 
 
There are two ways to set the correct datum and projection, either specify in project settings, or use 
an existing layer projection.   
 
Use Existing Projection 
If users have been supplied with map layers, some of these may have a projection set. The first 
layers that the user adds will be checked for projection data (an  ESRI-style ".prj" file containing 
Well-Known Text (WKT) projection  information). If a .prj file is found, the project will adopt that 
projection. This information can be viewed under the file/settings menu.  
 
Specify Projection 
If you know that the data you have been supplied is in the local projection, but this does not show 
as a .prj file, you can specify this in the Project Settings (see section above).   
When the Project Settings list is open, in the Project Projection section; 

� Category – select the appropriate category -  
� Group  - select the group your datum is in  
� Name – select the regional projection (if relevant) 
� Show Mismatch Warning – leave as True 
� Use Projection Info – Select as True 

 
When additional layers are added, if they are in the same projection, they simply load. If they are in 
a different projection or have no projection information, then the user is asked how they would like 
to handle the situation. The default is to set or reproject the new layer to the defined project 
projection. If the layer has not projection information, you may choose not to set a projection. 

Loading an Existing Project  
If you have previously created a project, or wish to use one of the sample projects supplied; 

• Click on the Project name in the [Open Project] list of the welcome screen if it shows, or 
• Click on [FILE]  Click on [OPEN]  
• Browse to the appropriate folder 
• Select a Project file (ends in .mwprj) and Click [OPEN]  

NOTE - Several examples of project files can be found at C:\Program Files\MapWindow\Sample 
Projects\  

Saving a Project  
While working on any project, it is advisable to save regularly to guard against data loss and for 
later retrieval. When saving a project for the first time, it is necessary to provide a name and 
location for the project file. It is important to note that a saved project file does not contain any map 
data. The project file contains references to map data, as well as other information such as layer 
symbology.  

• Click [FILE] on the Main Toolbar, or the  icon .  
• Click [SAVE]. If this is the first time the user has saved the project, the user will be 

prompted to provide a path and filename. Click the [SAVE] button  
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Adding Map Data or Layers 
There are two main types of data to add or show in MapWindow, Raster and Vector. 
 
Raster data is generally imagery, such as aerial or satellite images.  
Vector data is generally composed of shapes or layers of some form –and will be in the form of 
shapefiles. 
 
MapWindow supports three different types of Shapefiles:  

 
 

� Point Shapefile: Composed of individual points. Cannot have vertices, as the point itself is 
the shape.  

� Polygon Shapefile: Composed of solid shapes (areas) which are, in turn, composed of 
interconnected vertices. These are anchor points about which the lines composing the shape 
turn.  

� Polyline Shapefile: Composed of line segments that may be interconnected but don't have to 
be. Can have vertices; these can be anchor points about which a line turns, for example.  

 
Each GIS data set will be added to the map project as a single layer  

� Add data by clicking on  icon, or by clicking on [VIEW] then [ADD LAYER]  
� When the Add Map Layer window opens, navigate to the data directory the user wants, then 

click on the GIS data the user wants to add it as a new layer in the users project.  
� To add multiple layers at once, hold down the control key and select each addition layer by 

clicking on it.  
� Click the [OPEN] button. The new layer/s will be added to the project  

 

Using the Legend to Control the Layers  
The legend is a graphical representation of all the map layers in the current project. The position of 
the legend is the left hand side of the screen. The legend offers layer manipulation functionality 
including but not limited to changing a layers symbology or the order of display for the layers. The 
legend is always displayed  
 

� Visibility Checkbox: This indicates whether a 
layer is always visible (checked) on the map 
screen, or always hidden (blank).  

� Text: This is the name of the layer.  
 
Each line represents a layer of data that's in the main view. The image to the right of the legend is 
an indicator to help identify the data layer. If, for example, the user had a polygon Shapefile that 
was filled, the colour in this image would be the same as the fill colour. For a line Shapefile, the 
colour here will match the colour the line is drawn with. 
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Right Click Functionality  
If users right click (right mouse button) over the Legend, the menu below shows; 

� [ADD GROUP]  bunch a selected set of layers under a common header  
� [ADD LAYER]  
� [REMOVE LAYER] – Removes a layer from the project 
� [CLEAR LAYERS]  Removes all layers  
� [ZOOM TO LAYER]  
� [VIEW METADATA]  
� [VIEW ATTRIBUTE TABLE] – this is the table behind most layers which can contain a 

range of information on shapes, such as names, size, x & y coordinates etc. 
----------------------------------------------------------------------------------------------  

�  [EXPAND GROUP]  
�  [EXPAND ALL]  
�  [COLLAPSE GROUP]  
�  [COLLAPSE ALL]  

----------------------------------------------------------------------------------------------  
�  [PROPERTIES]  

Changing the Drawing Order:  
The legend indicates the order that layers are drawn in. The first layer in the legend is the top layer 
of the map. The last layer in the legend is the bottom layer on the map. The layers are drawn from 
bottom up, hence the bottom layer is drawn first then the last but one layer and so on. As a result is 
it important to carefully order the users map layers so data is not obscured by layers placed on top.  
 
If you have imagery displayed, this is best to ordered to the bottom of the layer list, to make it 
background for all other layers on top. 
 
To change the order of a layer, in the legend, click and drag a layer to the desired location.  

Using Groups to Order Layers 
If you have large numbers of layers loaded, the legend can become cluttered and require users to 
scroll up and down to find the relevant layers.  The Group option allows you to bunch layers 
together, and expand or collapse this group or re-order a whole group of layers. 
 
To add a new Group; 

� Right-click on the Legend and select [ADD GROUP] 
� Name the Group in the dialog and confirm 

To add layers into a Group; 
� Select the appropriate Group you want to add layers to 
� Add the layers as per normal, or click and drag existing layers into the group 

Removing a Layer from the Map  
Removing a layer does not remove or delete the underlying data, it just removes the reference to the 
layer from the project.  

� Right-click on the layer in the legend, a new menu will popup.  
� Click on [REMOVE LAYER]  
� Or select the layer, click on [VIEW] then [REMOVE LAYER].  

If the user right-click on a layer in the legend, a new menu will popup. By selecting [CLEAR 
LAYERS], it will ask the user to confirm and then remove all layers.  
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Changing the Layer Display properties.  
Changing the properties of a layer does not affect the underlying data. The layer properties are 
project dependent and will not modify any information stored against the map source.  
 
To change the layer properties, double-click on the layer in the legend and the Legend Editor 
appears (right);  
� To change the Coloring Scheme – see section 

below 
� Change the text in the Display Name box. This 

will be the new layer name displayed in the 
legend and on printed maps.  

� Fill Color – click on the coloured box to open a 
colour chart to change the fill colour for polygon 
shapes 

� Fill Style – can be used to select hatched or lined 
fill 

� Label Setup – see section below for more detail 
� Line Style – use this to change the style of lines 

for line shapes 
� Line Width – change how thick a line will 

display. 
� Outline Colour – can change the outline for a 

polygon to the same or different colour as the Fill 
colour. 

� Show Fill – this will turn the fill colour on (true) 
or off (false) for polygons.  To have a clear 
polygon, select False. 

� Transparency Percent – sets how transparent the 
fill for polygons can be – 0 means the fill will 
block everything behind it.  Higher number will 
allow items behind the fill to show through. 

Click the [X] button to close the Layer Properties 
dialog. The legend will update to show the new layer 
properties. Then save the users project  

Creating a Layer Coloring Scheme 
The Coloring Scheme allows user to distinguish between 
features in a layer using different colors.  To enable; 
� Open Legend editor for the layer as above 
� Layer  
� Click on Coloring Scheme, then click on the icon at 

right, the box at right will appear 
� Select the field in attributes to differentiate color on 
� Select the number format which suits 

� Click on the  predefined schema icon and select from the options,  
� or Use the add icon to specify colors for each class 
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Making the Layer Scalable  
Making a layer scalable will result in a layer not showing on a map until the user has zoomed into a 
particular scale.  This is useful for layers that show far too much detail when viewing an entire area, 
such as property boundaries, but are useful when zoomed in. To do this: 

� Zoom into the scale that the user want the desired layer to appear  
� Double click on the layer in the legend  
� Click the Dynamic Visibility Disabled line and a drop-down arrow will appear. Click on the 

drop-down arrow  
� Put a check in (Use Dynamic Visibility) Click on the drop-down arrow again  
� Click the [USE CURRENT EXTENT] button  
� Close the Legend Editor.  

NOTE: If the user set up a dynamic visibility, and then unselect the layer in the legend, it will reset 
the dynamic visibility to disabled. This means the user will have to reset it again.  

Adding a Label to a Layer  
Labels are an easy way to add dynamic textual labels to geometry features on the map. 
MapWindow will extract a field from the map data to be used as the label text. To add labels to a 
layer; 

� Double Click on the layer in the legend window.  
� Click on Label Setup  

.  
 

� Click on the  button on the Label Setup line.  

 
 
Select the (Label Field for First Line) drop-down and select the field to label with.  
 

� Change the colour if 
required, and select Use 
Label Shadow if required 

� Click [Apply] to check how 
these changes look, then 
[OK], or just [OK].  

 
 
 
 
 
 
 
 
 
 
To remove the labelling for a layer, set the (Label Field for First Line) value to none.  
Click OK to close the window, and labels will disappear.  



Quick Guide to MapWindow   15 

Display and Modify Map Scale Bar 
The Floating Scale Bar will automatically show the map scale, modifying as users zoom in and out.  
To show the Floating Scale Bar on maps: 

� Click [View] then click on [Show Floating Scale Bar] 
 
Users can modify the Scale Bar display, ie units, colour, text size and location on the map. 
To modify Scale Bar display; 

� right click on the Scale Bar to open a new menu 

� select from display options and select settings you wish.  
 

 
Moving Around a Map  
 
When working with a map it may be necessary to zoom in to view an area in more detail, or zoom 
out to see a larger area, or pan to move the view around.  
 
If the users mouse has a scroll wheel on top, it can be used to zoom in by rolling it forward, or 
zoom out by rolling backward.  

Zooming In 
� Click the [ZOOM IN] button on the Tools toolbar, move the mouse over the map, single 

click to zoom in around a point.  
� Zoom in to a specific area. Click and hold the left mouse. Move the mouse to drag a 

rectangle to create the area the user wish to zoom to. Release the mouse button to complete 
the zoom.  

� When in Zoom Out mode, a right-click on the mouse will zoom in.  

Zooming Out  

� Click the [ZOOM OUT] button on the Tools Toolbar, move the mouse over the map. 
Single Click to zoom out around a point  

� When in Zoom In mode, a right-click on the mouse will Zoom Out  

Zooming to Full Extent  
Zooming to full extent resets the map view so that every feature of very layer is contained within 
the visible extent  

� Click the [ZOOM] button on the Tools toolbar  
� Select [FULL EXTENTS] in drop down menu  

Zooming to Previous or Next Extent  
Zooming to previous extent allows stepping back through past map views. For example, start with a 
map view at full extent then zoom in to an area on the map. Now click the previous extent button; 
the map will return to the most recent previous map view, which was the full extent.  

� For Zooming To Previous Extent  Click the [ZOOM] button on the Tools Toolbar then 
select [PREVIOUS] on drop-down menu  

� For Zooming To Next Extent  Click on the [ZOOM] button on the Tools Tool bar then 
select [NEXT] on drop-down menu  



Quick Guide to MapWindow   16 

Zoom to Layer Extent  
Zoom to a layers extent will set the map display to an area just big enough to show every feature in 
the currently selected layer.  

� Right-click on the layer in the legend, a new menu opens. Click on  [ZOOM TO LAYER] 
� or 
� Click on the [ZOOM] button on the main toolbar then [LAYER] on drop-down menu  

Panning  
Panning allows the user to move the map display around to show areas outside of the current 
viewing area without changing the scale of the map.  

� Click the  button on the Tools toolbar.  
� Move the mouse over the map.  
� Click and hold down the left mouse button.  
� Move the mouse, still holding down the mouse button. The map will move with the mouse.  

Release the mouse button to complete the pan operation 
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 Editing and Creating Data or Layers 

Setting up Data Folders 
Before you start to create new data and projects, it is best to setup the folders for storing your GIS 
datasets in. 

� In My Documents add a folder for all data, eg GIS or Mapping 
� Create sub folder/s in this folder for your supplied layers, eg imagery, and base data 
� Create sub folder/s for your created data layers, eg Works, GPS,  
� Add your Project files to the main folder (GIS) to make it easy to find the project file 
� Add data layers to the sub folders – keeping these separate from projects and base data. 

Creating a New Layer  
First, the Shapefile Editor plug-in must be enabled.  Click on [Plug-ins] and tick [Shapefile Editor].  
This will add the Editor Icons to the Toolbar. 

To create a new layer for editing, choose  [Create New Shapefile] from the main menu. 
 
The New Shapefiles Options dialog will be displayed.  

� Choose the type of layer (point, 
line, or polygon). 

� Click on the button to the right of 
the Filename box, which will 
open the browse dialog. Browse 
to the appropriate folder to store 
your layer in, type in the 
filename for the layer. 

� GIS naming options are best to avoid using blanks in the names of files, but use dash or 
underscore between names, eg instead of site poly.shp use site_poly.shp.  This will avoid 
issues with sharing the data. 

� Use the default option for setting the layer’s projection to the Project projection, by clicking 
OK 

� Click OK on the next warning box. 
� The layer is now ready to add shapes to. 
� It is good practice to modify the Attribute table now, to setup the required fields for the 

layer.  See section on Editing a Layer Using Table Editor later. 

� To add a shape to the layer, click on the  button and commence adding by clicking on 
the appropriate points for each point or vertice.  Right click to finish each shape. 
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Editing a Layer 
MapWindow supports basic capabilities for editing spatial data. Before performing any edits, 
always make a backup of the dataset the user is about to edit. Key files to copy when backing up a 
shapefile include any files ending in .prj, .dbf, .shp, and .shx.  
 
To edit an existing layer, highlight the layer in the legend.  

� Add attributes by clicking on the  button and moving the curser to the point to be added.  
� Enter x, y values by left clicking on the location where a point or vertex should be added.  

� To move a point, click on , then select the point to be moved by left-clicking on it, then 
drag the selected point to the correct location and release the mouse button.  

� To delete a shape from the shapefile, first click the Select icon  from the toolbar. Next, 
select one or more shapes to be deleted with the mouse. They will change colour to indicate 

they’re selected now, press the Delete Shape button . The user will be asked if the user 
is sure; after answering [Yes] the shape(s) will be deleted.  

� If the shapefile being created is a Polygon or a line, the user can add or remove  a 
vertex from the existing shapefile.  

Using Table Editor to Edit Attribute Table 
This allows users to edit the table or data in the attribute table.  This is the table of information 
which sits in the background of a layer. 
 

� Highlight or select the layer in the legend.  

� Click on  to open the attribute table for editing  
� The following view will open:  

 

 
� Select [Edit] then 

o [Add a Field]  add an attribute column to the attribute table.  
o [Remove a Field]  deletes an attribute column from the attribute table.  
o [Rename a Field]  Change the name of an attribute column.  

 
To edit the content of any cells in the table, click on the cell and enter the required information 
If you select to add a field, the following view will open; 

 
The type can be one of the following: Double, Integer, or String.  
 
If Double is selected, the precision, or places to the right of the 
decimal point, is enabled.  
String is used for text content fields. 
 
 
 

 



Quick Guide to MapWindow   19 

Finding Map Information  

Querying Map Features  

� Identifying features - The identify tool  is the simplest way to retrieve attribute data 

about a feature on the map. Clicking the Identifier button ( ) will activate the Identifier 
plug-in, and set the mouse cursor into identifier mode.  

� Select the layer to query in the legend. (The 
darker rectangle indicates the selected layer).  

� If a shapefile layer is selected, the identifier 
window will be put into Shapefile mode, as 
seen right.  

� When the user clicks on shapes in the 
Shapefile, the table will show information on 
them.  

� The identify result tool has a limited radius of 
effect when clicking. The mouse button may 
be held down and dragged to form a box; 
features within this box will be shown in the 
identifier.  

 
 

Measuring distance  
The measurement tool is used to calculate distances between two or more user-defined points on 
the map.  

� Click on the [MEASURE DISTANCE]  Tool  
� Click on the first point  
� Click on the next point  
� On the bottom left of the main application window, the cumulative distance is displayed. 

Right Click to start over again with new measurement.  

� Click the  button again to unselect it and leave Measure mode.  

Measuring Area  
The measurement tool is used to calculate the area between three or more user-defined points on 
the map.  

� Measure Area Click on the [MEASURE AREA]  Tool  
� Click on the first point, click on the next point and as many points as needed to complete 

the border around the area needed to be measured  
� Right Click to end and see the results of the area measured.  
� Click [OK] to resume map functions.  
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Printing Maps 
Presently, the printing functionality in MapWindow is not very extensive. It is, however, under 
very active development and we expect a much-improved printing interface soon.  
 

� In order to print the current map view, select the [File] menu  
� Select [Print]. The user will be presented with a dialog (shown below) which allows the user 

to select what map elements the user would like displayed.  
� It is advisable to select the Visible Layers only, as this will not print layers loaded in the 

project but not visible on the map 
� Select the other options as preferred 

 
� Select [Properties] and set up the users windows printer. Press [OK]  
� Select [Print Preview] to check for changes.  
� Select [Print].  

 
If users prefer to print a different map, then it is possible to export particular elements to insert into 
a word processor or publishing program to make it more effective. 
 

Exporting Maps 
The user may export a map image as a range of formats to include in a range of other word 
processing or publishing documents.  

� To do this, select the [Edit] menu  
� Select [Export]  
� Select [Map]. The user will be presented with a dialog asking where the user would like to 

save the file.  
� Specify where the user want to save the map and also the file extension ( .jpg, .bmp or .gif), 

then click [OK]  
 
The user may export a scale bar by selecting the [Edit] menu, then [Export], then [Scale Bar]. This 
will prompt the user for a location to save the resulting image file. This file could then be used in 
word processing or publishing software.  
 
The user may export a north arrow by choosing the [Edit] menu, then [Export], then [North Arrow]. 
This also will prompt the user for a location to save the image.  
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Other Useful Tools 

Update Measurements Plug-in 
This is an additional plug-in which allows users to calculate line length or polygon area and 
perimeter, and add these to the attribute table.  Users will need to download the plug-in and switch 

it on.  This installs the Update Measurements  icon on the toolbar. 

Calculate Line Length  
To add a field in the attribute table which contains the length of the 
lines; 

� Click on  icon 
� The box at right appears 
� Select the layer to update from the list 
� Select the correct shapefile units (if not already populated) 
� Select the units for the calculations to be made in 
� To use an existing field in the attributes, select ‘Existing’ 

and the field name from the list 
� To create a new field, select ‘New’  

o Length will be added by default to the name, or 
rename to preferred 

o select the number of decimal places  
� Click [Update Measurements] button 

If further layers are to be updated, then repeat as above, or click 
[Close] button to close box. 
 

Calculate Polygon Area & Perimeter 
To add a field in the attribute table which contains the area and/or 
perimeter of the polygon; 

� Click on  icon 
� The box at right appears 
� Select the layer to update from the list 
� Select the correct shapefile units (if not already populated) 
� Select the units for the calculations to be made in 
� Note – meters is the default for Perimeter units 
� For each of either Area or Perimeter 
� To use an existing field in the attributes, select ‘Existing’ and 

the field name from the list 
� To create a new field, select ‘New’  

o Length will be added by default to the name, or rename 
to preferred 

o select the number of decimal places  
� If either field is not required, select ‘None’ for these 
� Click [Update Measurements] button 

If further layers are to be updated, then repeat as above, or click 
[Close] button to close box. 
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Polygon Areas – GIS Tools option 
If users only require Polygon Areas to be calculated, without the need for additional plug-in; 

� Click on [GIS Tools]  
� Click on [Vector]  
� Click on [Calculate Polygon Areas]  
� If it cannot detect the shapefile units a warning will show asking if you wish to use the 

units in the projection.  Click OK 
� The box at right appears 
� Select the layer.  
� Set the shapefile units (Meters) 
� Set the units of the area the user 

want created (Hectares) 
� If this is the first time, select the 

Use a new field called – and give it 
a new name such as Hectares 

� If there is already an area field, 
select Update an existing Field, and 
select the field from the list 

� Click on [Calculate]  
� Your field will now have the 

hectares calculated. 
 
The option to specify decimal places is not 
in this tool. 
 
 
 
 
 
 

Document Launcher  
Functionally, this particular plug-in will be activated when a shape in a shapefile is selected. If the 
shapefile has an attribute entitled FileOrURL and the selected shape has text in that attribute 
column, then the plug-in will seek to launch that path as a file or a URL.  
 
Most commonly, this is used to launch images or web pages associated with given shapes.  For 
instance, if the field contained a link to a photo, then the photo would be displayed.  
 

� Users will need to add a field to the layer attribute table named FileOrURL as a text field 
� This field will need to have the full path information on the relevant document in the field 
� Click on the [Plug-in] button on the main menu  
� Select [Document Launcher].  

� When an item is selected using the selection  button, the program will try to find the 
file and open in the relevant program. 
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Buffer Shapes (GIS Tools - Vector)  
This tool creates buffer shapefiles at selected distances from the original features.  

� Ensure GIS Tools plug-in is enabled  
� Click on [GIS Tools]  
� Click on [Vector]  
� Click on [Buffer Shapes]  
� Select layer to buffer  
� Decide if buffering is applied to all shapes 

or just selected ones.  
� If selecting features, click to select feature 

to buffer, or hold down control key and 
click on multiple features.  

� Select distance; remember it is the same 
units as the users data.  

� Set name and browse to folder for 
resulting shapefile to be saved in 

� Click [OK]  
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Making Polygons or Lines from Points layers 
This may be useful if you are using a GPS and software which generates a point Shapefile from 
waypoints downloaded from the GPS, or using the CSV to Shapefile plug in.   Users can then 
‘snap’ features (such as a line or polygon) to these points to create the new shape.   
 
Some software useful for GPS download is DNRGarmin, which allows users to connect to a 
Garmin GPS unit and download waypoints or tracks to convert into maps. This is available from 
the US DNR website 
http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html  
 
For other GPS units, there is a range of other free software which may be able to download 
waypoints and convert to shapefiles.  Try websites such as www.maps-gps-info.com for lists of 
available software.   
 
The concept of snapping features to other layers means that when generating a vertex for a shape 
close to the relevant point, MapWindow will force the new vertices to have the exact coordinates as 
the features on the first layer.  This avoids errors where the vertices may be slightly offset when 
created manually. 
 
The general process for generating a line or polygon Shapefile based upon points from a GPS is: 
 

� Load your points layer into MapWindow.  It may be useful to label this layer with the Ident 
field – which should show the waypoint number (if from GPS). 

� Ensure GIS Tools and Shapefile Editor are both switched on in Plug Ins, and zoom into the 
relevant section of the points layer 

� Create a new (line or polygon) layer – click on  and select type 
� Click on [Shapefile Editor] and ensure there is a tick next to [Snap to vertices]  and [Snap to 

All Layers] 
 
To create a shape, follow the instructions as per Editing a Layer section; 

� Add a new shape using  button 
� Move the cursor close to the first point, you may see the + move over the point – click once 

to create the vertex 
� Move the cursor to the next point for the site, and repeat until you have created a vertex on 

the last point. 
� To close the polygon, or finish the line, right click, which will finish the shape. 
� Repeat for each new shape as required. 

 


